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Add a contact to a contact list/address book  
 
Instead of typing email addresses into the To box every time, it is possible to save them 
into your contact list, also known as an address book, which is ready to easily use when 
sending an email. 
 
Open Microsoft Outlook 2010. 
 
Click on Contacts on the bottom left of the screen. 
 
If you have saved any contacts to your address book, they 
will be showing in your contact list. 
 
 
 
 
 
 

To add a 
new 
contact, 
click on 
the Home 
tab and 
then on 
the New 
Contact 
button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Continued on next page  
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A box will open for 
you to enter the 
contact’s details. 
 
Type the details of 
the contact into the 
relevant boxes. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
When you have entered all the 
details for the new contact, click 
on the Save and Close button. 

 
If you need to add more 
contacts, click on the Save and 
New button. 
 
The contact will then be saved in 
your contact list.  
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Add stationery to an email 
 
This is an example of stationery available for you to choose when using Microsoft 
Outlook.  

 
Open Microsoft Outlook. 
 
Click on the Home tab,  
 
click on the New Items button, in the New 
group, 
 
click on Email Message Using,  
 
and then on More Stationery.  
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Choose one of the 
stationery items listed.  A 
sample of the design will 
show on the right of the 
dialogue box. 
 
Click on the different 
designs to see which you 
prefer. 
 
Click on your final choice 
of design and click OK. 
 
A new email will then 
show with your chosen 
design on it. 
 
 
 
 
 
 

Attach a file to an email 
 
It is possible to send an email to someone with files or photographs attached. 
 
Create a new email.  (See create a new email in this information pack.)  

 
 
 
 
 

Continued on next page  
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To attach the file to the email, click on the Attach button on either the Message 
tab or the Insert tab. 
 
The Insert 
File dialogue 
box will open. 
 
Open any 
folders if 
needed.  
 
Click on the 
file you would 
like to attach 
to the email 
and click on 
the Insert 
button, 
 
or  
 
double click 
on the file you 
would like to 
attach. 
 
 
 
The file will then 
be attached to 
the email.  When 
the email is sent, 
the file will be 
sent with it. 
 
The file can then 
be opened or 
saved by the 
person who  
receives the 
email. 
 
It is possible to 
attach more than 
one file to an 
email. 
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Blogs 
 
A blog is a website or part of a website where a log of events can be written and added to.  
It can be, for example, a log of events about a particular piece of news.  It can be text and 
images and there is a facility for the readers of the blog to add their comments.  
 
Readers of the blog can enter comments in response to what they have read or 
communicate with each other.  There are millions of blogs available to us now.  Many 
provide up to date news about a particular topic. 
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Change the font of an email message 
 
Here are several ways to change the 
font of your emails. 
 
Method One 
 
Click in the message part of the 
email. 
 
Select the text you would like to 
change. 
 
Click on the Message tab and then 
click on the Basic Text dialogue box 
launcher. 

 
The Font dialogue box will then 
show. 
 
Change the Font, Font style, Size, 
Effects and Colour to your choice. 
 
Click on the OK button.                                                                      
 
Method Two 
 
The font can be changed using the buttons on the Message tab.  If only part of the text is 
selected, it will change only the selected text to the new font. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Changes the 
font type 

Changes the 
font size 

Changes the 
font colour 

Changes the 
font to bold 

Changes the 
font to italic 

Changes the 
font to 

underlined 
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Change the style of your emails 
 
There may be times when you want to change the look of the emails you send, to make 
them look more attractive, less or more formal.   
 
It is possible to add stationery to your emails, which in effect is adding a template.  This 
can include a background image and different font colours. 
 
Emails can be formal, for example, for sending a job application, or less formal such as 
keeping in touch with a friend.   
 
The language used for each of the messages would be different. 
 
The style in which you write an email has to be adapted to suit the person you are sending 
the email to.  Some people use text language on emails to friends. 
 
An email to a friend can be written using text language.  It is a chat between friends and 
spelling mistakes do not matter. 
 
An email to a person in business should be more formal.  An email can be a binding 
document and it is important to make sure it is giving the right impression about you to the 
person you are sending it to.  It may be a potential employer.        
 
There are two examples following.  If you were emailing for an application form, example 
two would be more appropriate. 
 
Example One 
 
Please wud u send me an app form 4 the clerical assistant job advertised in the local 
paper?   
 
Cheers 
 
 
Example Two 
 
Hello 
 
I would like to apply for the Clerical Assistant post advertised in the local paper.  Please 
send me an application form. 
 
Thank you 
 
 
In a friend’s email, you may use abbreviated text as if you were sending a text message on 
a mobile phone.  An example would be if it was ended with C u soon. 
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Close a program 
 
When you have closed all the documents, you will need to close the program. 
  
Click on the   in the top right corner of the window and the program will close. 
 
 

Copy an email to another person 
 
It is important to think about whether you would like to copy anyone in on the email you are 
sending.  If you think someone else needs to know the contents of the email, for example, 
a work colleague working on the same project, you may want to copy that person in on the 
email. 
 
Be careful not to copy other people in on information which is confidential.  Very 
often several emails are passed between people and the contents of them are still 
showing under the current email.  It is worth checking to make sure the contents of 
the previous emails are not confidential before copying anyone in. 
 
There are two ways of copying someone in on an email, Cc and Bcc. 
 
You can send the email to more than one person by entering more than one email address 
into the To box. 
 

Cc 
 
If you want to send a copy of an email to 
another person in addition to the person in 
the To box, you can use the Cc or Bcc box 
to do this. 
 
It is possible to use the Cc box to enter 
another person’s email address.  This can 
be done by directly typing the email address 
into the Cc box or by clicking on the Cc 
button and then choosing the email address 
from your contacts. 
 

Bcc 
 
The Bcc box is used if you want to send a copy of an email to another person in addition 
to the person in the To box, but you do not want the person in the To box to know the 
other person has been copied in.   
 
This can be done by directly typing the email address into the Bcc box or by clicking on 
the Bcc button and then choosing the email address from your contacts.  
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Create a new email 
 
The example used is created in Microsoft Outlook.  You may not be using this, but there 
will be similar buttons in the program you are using. 
 
To create a new email, you will need to click on the button in the email 
system to start a new email.  Different systems say different words for this.  
Usually it will be New, Create or Compose.   
 
In the case of Microsoft Outlook 2010, click on the File tab and then on the 
New Email button. 
 
Enter the address of the person you are sending the email to in the To box. 
 
Enter the address of the 
person you would like to 
receive a copy of the email in 
the Cc box.  
 
Enter a subject e.g. “Friday 
night”, into the Subject box.  
This should be a few words 
which will summarise the 
contents of the email.  It 
makes it easier to look 
through the emails without 
having to open them. 
 
Enter the message in the 
area under the subject box. 
 
Check the email makes 
sense. 
 
Click on the Send button. 
 
The email will then be sent. 
 
When the email has been sent, it can be stored in the Sent Items folder in your email 
software.  (Some programs give you a box to tick for this to happen.)   If you need to, you 
can access it from there. 
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Create a folder for contacts in your contact 
list/address book 
 
It is possible to put your contacts into different folders.  
This may not be necessary if there are only a few 
contacts and they are easy to see.  If there are 
hundreds of contacts in a contact list, it may be easier 
to find if they are in folders.  
 
To create a folder in the contact list, you will first need 
to open the contact list by clicking on Contacts at the 
bottom left of the screen. 
 
 
Click on the Folder tab, click on the New Folder 
button. 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
The Create New Folder dialogue box will 
appear. 
 
Type a suitable name for your folder in the 
Name box.  This 
should be a name 
that you will 
instantly 
recognise, for 
example, a 
company name 
for the contacts 
within that 
company. 
 

Click on the OK button and the folder will be created.   
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Delete a contact from a contact list/address book 
 
You may want to delete a contact from your contact list.   
 
To do this, click on the Contacts button on the left panel 
of the screen and, when the contacts show, click on the contact which you would like to 
delete and either: 
 

click on the Home tab menu and then click on the Delete button in the Delete 
group, 

or 
right click on the contact’s details and click on Delete, 

or 
 click on the contact and press the delete key on the keyboard. 
 
The contact will then be deleted from the contact list. 
 
 

Delete an email message 
 
There are several ways of deleting an email in a system. 
 
The example used is Microsoft Outlook.  You may not be using this, but there will be 
similar buttons in the program you are using. 
 
Method One 
 
Open the Inbox. 
 
Select the email you 
want to delete by 
clicking on it.  You 
may have to put a tick 
in a box to do this in 
some email systems. 
 

Click on the 
Delete button 
in the Delete 
group,  

or  
press the Delete key on the keyboard, 

or  
press and hold down Ctrl on the keyboard and then, whilst still holding the Ctrl key 
down, press D. 

 
The email will be deleted.                                                                Continued on next page  
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Method Two 
 
Open the email. 
 

Click on the 
Delete button in 
the Delete group, 

or  
press the Delete key on 
the keyboard, 

or  
press and hold down 
Ctrl on the keyboard 
and then, whilst still 
holding the Ctrl key 
down, press D. 

 
The email will be deleted. 
 
Once deleted, the selected 
message will be moved to a deleted items folder (sometimes called the trash folder). 
 
If you have deleted the wrong message, you can get it back again. 
 
Click on the Deleted items folder and select the message. 
 
Click on the option to move to a folder and then select the Inbox as the destination 
folder. 
 
 

Delete text 
 
Select the text you want to delete and press the Delete key on the keyboard. 
 
 
Another way is to click in the email where you wish to delete the text.  You can also use 
the arrow keys to move the cursor around the email if you want.  The cursor is the flashing 
line on your page, which tells you where you are in the email. 
 
To delete text to the left of the cursor, click on the Backspace key on the 
keyboard. 
 
To delete text to the right of the cursor, click on the Delete key. 
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Edit details of a contact in a contact list/address book 
 
To do this, click on the Contacts button on the left panel  
 
of the screen.  When the contacts show, double click on the contact that you would like to 
edit. 
 
The contact’s details will then be shown. 

Click in any of the boxes and edit the details as needed.   
 
To save the changes, click on the Contact tab, then on the Save and Close button 
in the Actions group.  
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Forward an email 
 
If you receive an email and then want to forward it to someone, either: 
 

open the email and then click on the Forward button in the Respond group, 
or 

from the inbox, click on the Home tab, then click on the email you want to forward 
without opening it and click on the Forward button in the Respond group. 

 
The box will open to allow you to choose who to forward the email to in the normal way. 
 
It can then be sent. 
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Forums 
 
A forum on the Internet is a website or part of a website which allows discussions on 
various topics.  A forum may contain many discussion topics.  Each one is known as a 
thread. 
 
In order to join in the discussions on a forum, there is very often a log in needed with a 
username and password.  It is possible to reply to individual messages with comments.  It 
is usually set up to allow users to set up new discussion topics.  There are various names 
for these forums.  These include message boards, discussion forums, bulletin boards, etc. 
 
They allow topics to be discussed by a group of people without them all being on the 
Internet at the same time.  Each topic may have many discussions.   
 
 

Insert text 
 
Click in the email where you wish to insert the text.  You can also use the arrow keys to 
move around the email if you want.  See Move around using keys in this information 
pack.  Then simply begin to type.  The old text will move along as you insert the new 
words.  
 
 

Instant messaging 
 
There are systems which allow you to chat online.  There is usually a system that tells you 
who, out of your contacts, is online at the current time.  A chat box for that person will open 
which will allow you to type a message.  It is then sent to allow the other person to read it.  
They can then, in the same box, reply to your message and so on.  This means a 
conversation can take place without having to wait for emails to be opened.   
 
If a web cam is used with the instant messaging, then it is possible to see the person you 
are chatting with.  It is also possible now to talk using the Internet.  This can be free and is 
therefore better than using the telephone, particularly if you are speaking to someone in 
another country. 
 
 

Maximise the window 
 
There are buttons in the top right corner of any window.  They look like this   

or  

 
This makes the window smaller and allows you to alter the size of the screen. 
 
This makes the window full screen size (maximised).  
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Move around using keys  
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Move contacts to a folder 
 
It is possible to move contacts from one folder to another within the contact list. 
 
Open the contact list and then click on the contacts you would like to move to a different 
folder. 
 
It is possible to select 
more than one contact 
at a time by holding the 
Ctrl key down and 
clicking on each of the 
contacts you would like 
to move. 
 
To move the contacts 
into a different folder: 
 
Method One 
 
Click on the 
Move button in 
the actions 
group. 
 
Click on the folder you 
wish to move the 
contacts into or, if it is 
not in the list, click on 

Other Folder. 
 
When the Move Items dialogue box 
opens, click on the folder where you 
would like to move the item to and then 
click on the OK button.   
 
The contacts will then move into the 
chosen folder. 
 
Method Two 
 
It is also possible to select the contacts 
from the contacts list that you would like 
to move, drag them to the folder of your 
choice and then drop them over the top 
of the folder.   
 
The contacts will then move into the chosen folder.  
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Netiquette 
 
Netiquette is the unwritten rules of the Internet.  No one enforces these rules but people 
should be aware of them. 
 
 
Flaming 
 
When sending emails or any message to other people, it is important that you consider 
what you write.  Consider the feelings of other people who will be reading your message.  
Some people use message boards and discussion forums to sound off at other people 
without considering the other person’s feelings.  They appear to verbally attack a person 
rather than making a point or stating their opinion.  This is not good netiquette. 
 
 
Shouting 
 
Some people write emails and messages all in capital letters. 
 
THE USE OF CAPITAL LETTERS IN AN EMAIL GIVES THE IDEA YOU ARE 
SHOUTING.  
 
Avoid doing this as it is not good netiquette. 
 
 
Spam mail 
 
There are many companies which send out junk emails to everyone.  This is known as 
spam.  This is not good netiquette but it is difficult to stop people or companies doing this.   
 
It can fill up your email inbox with rubbish.  Some of these emails may contain viruses 
which, if opened, will affect the running of your computer.  It is important to delete any 
spam which arrives in your inbox as soon as possible without opening it.   
 
There are many programs now which will help to cut down the amount of spam sent to 
your email inbox.  These are known as anti-spam software or spam blockers. 
 
 
Flooding 
 
There are some people who join in discussions on forums and cannot stop themselves  
re-entering their opinion over and over again.   
 
This is known as flooding.  The point of a discussion forum is to get a lot of people’s 
different ideas and allow everyone to voice their opinion.  Be aware of this when joining in 
discussions.  Flooding can be bad netiquette. 
 
  



 EMAIL 
 INFORMATION 
 

©West Nottinghamshire College    22 

Excellence in skills development 

 
 

Open a contact 
list/address book  
 
Instead of typing email addresses 
into the To box every time, it is 
possible to save them into your 
contact list, also known as an 
address book ready to easily use 
when sending an email. 
 
Open the contacts in your email 
system by clicking on the Contacts 
button in the email system. 
 
If you have saved any contacts to 
your address book, they will be 
showing in your contact list. 
 
There may be folders within the 
contacts list which you may also 
have to open. 
 
 

Open a program e.g. 
Microsoft Outlook  

     
 

Click on the start button.  
 
 Click on All Programs. 

 
Click on Microsoft 
Office.  
                                                            
Then open Microsoft 
Outlook by clicking on it. 
 
 
 
 

A shortcut way to open Microsoft Outlook 
 
If this icon is on your desktop, simply double click on it.   
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Open an attachment 
 
There are several ways of opening an 
attachment.  Three methods are described 
below. 
 
Method One 
 
Open email message. 
 
Double click on the attachment and it will open. 
 
 
 
 
 
 
 

 
Method Two 
 
Open email message. 
 
Right click on the attachment to be 
opened. 
 
A menu will appear.  Click on Open and the 
file will open. 
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Open an email 
 
Open the inbox of your email system.  
 
Double click on the email and it will open for you to read. 
 

 
Once an email is opened, at the top it will say who 
it is from, who it is to and also who has been 
copied into it, if anyone. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  



 EMAIL 
 INFORMATION 
 

©West Nottinghamshire College    25 

Excellence in skills development 

 
 

Print a list of contacts 
 
Open the contact list in your email system.  If needed, open any folders to show the 
contacts you would like to print.   
 
To print a list of contacts, click on the File tab and then Print.   

 
It is possible to choose the layout for the printout of the contacts.  To do this, click on one 
of the options in the Settings and a preview will be shown on the right of the screen.   
 
When you have chosen the style you would like, click on it to select it and then click on the 
Print button. 
 
A full list of contacts within the open folder will be printed.   



 EMAIL 
 INFORMATION 
 

©West Nottinghamshire College    26 

Excellence in skills development 

 
 

Print an email 
 
Open the email that you would like to print. 
 
Click on the File tab and then on Print. 
 

The print preview of the email that you would like to print will show on the right of the 
screen. 
 
Then, click on the Print button and the email will be printed. 
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Read an email 
 
The example shown is Microsoft Outlook.  You may not be using this, but there will be 
similar buttons in the program you are using. 
 
When you have opened an email, this is what it looks like. 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
  

Select this button to 
write a reply to the 
person who sent this 
message. 

Select this button to 
send this message 
on to someone else. 

This is 
who the 
email is 
from. 

Shows 
when the 
email was 
sent. 

The email 
subject 
should 
describe 
the 
message.    

This is the 
content of the  
email. 

This is who the  
email was 
addressed to.  
This might be more 
than one person. 
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Reply to an email 
 
The example used is Microsoft Outlook.  You may not be using this, but there will be 
similar buttons in the program you are using. 
 
When an email is open, you can reply to that person by clicking on the Reply button. 
 
The name of the person you are replying to will be automatically entered into the To box.   
 
The subject of the email sent to you will be automatically entered into the subject box with 
RE: in front of it.  This can be changed, if you want, by removing the text and typing in a 
new subject. 
 
Below shows what happens in Microsoft Outlook when you have pressed the Reply 
button. 
 
 
 
 
 

You simply type your reply. 

Check the email makes sense and there are no spelling mistakes. 

Then, when you have finished, click on the Send button.  

Select this 
button to send 
this message. 

When you reply, the 
subject changes from 
Welcome to RE: Welcome. 

Type your 
reply here. 

This shows who the email is to.  When replying, it 
shows who the original email was from. 
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Request a delivery receipt or a read receipt 
 
It is possible for the email system to let you know when an email has been delivered and 
also when it has been read. 
 
Open a new message. 
 
Click on the Options tab. 
 
In the Tracking group, there are options for Request a Delivery Receipt and Request a 
Read Receipt. 
 
Click in the tick boxes to activate this to happen.  
 
The message can be written and sent as normal. 
 
Delivery receipt 
 
When it has been delivered to the person, an email will come back to you to say the time 
the email was delivered successfully. 
 
Read receipt 
 
When the person opens the email, another email will come back to say when it was 
opened.  
 
 

Resize and move a window 
 
There are buttons in the top right corner of any window. 
 
They look like this   or  
   

This closes the window. 
 
This minimises the window to a button at the bottom of your screen.   

 

This is an example of a button on the bottom of the   screen.  When you click on 
it, the window will display again. 
 

This makes the window smaller and allows you to alter the size of the screen. 
 
This makes the window full screen size (maximised).            
 
 

 
Continued on next page  
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Move a window 
 
Click on if it is at the top right of the window.  The window should then be smaller  
 
and not take up the whole screen.  
 
You can move a window to another place on the screen.  To do this, click anywhere on the 
bar (title bar) to the left of the buttons, keep your finger on the mouse 
button and drag the window. 
  
There are 6 dots on the bottom right corner of the window.  

 
Click on the dots.  Hold down the left mouse button and move (drag) the 
mouse until the window is the size you want.  It will alter in both width and 
length as you drag. 
 

You can also alter the size of the window by moving the mouse over the 
sides of the window until you get a double-ended arrow.  Left click, hold 
down the left mouse button and move (drag) the mouse until the window is 
the size you want.   
 

 
 

Save an attachment 
 
There are several ways of saving an attachment.  Three methods are described below. 
 
Method One 
 
Open the email message. 
 
Double click on the attachment to be saved.  This will open it in the appropriate software. 
 
Save the attachment in the usual manner using the software which the attachment has 
opened in. 
 
 
Method Two 
 
Open the email message.  
 
Right click on the attachment to be saved. 
 
A menu will appear, click on Save As and 
the Save Attachment dialogue box will 
appear. 

 
Continued on next page  
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Choose where you 
want to save the 
attachment, then 
click on the Save 
button and the file 
will be saved.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Method Three 
 
It is possible to save the attachment from the inbox, without opening the email. 
 
Open the inbox and click on the email containing the attachment to select it. 
 
Click on File tab and then click on Save 
Attachments. 
 
The Save All Attachments dialogue box will open 
showing a list of all the attachments to the email. 
 
All the attachments will be selected automatically.  If 
you do not want to save all of them, click on the one 
you do want to save.  If you want to save more than 
one, you will need to press the Ctrl key on the  
keyboard to allow you to select more  
than one. 
 
Then click on the OK button. 
 
The Save Attachment dialogue box will appear.   
 
Choose where you want to save the attachments, then click on the Save button.  The file 
will be saved. 
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Select text 
 
Another word for select is highlight. 
 
There are lots of ways to select text.  Below are some of the ways. 
 
Click at the beginning of the text you want to select.  Hold the left mouse button down and 
drag the cursor across the letters or words you want to select.  You can drag across as 
much text as you want.  It will be selected as you drag. 
 
Double click on a word to select that word. 
 
To select a paragraph, triple click anywhere in it. 
 
To select all the text in an email, press and hold down the Ctrl button on the keyboard and 
press A.   
 
 

Send an email 
 
Make sure: 
 

 the email address of the person you want to 
send the email to is in the To box;  

 

 the subject of the email is in the Subject 
box;  

 

 the message has been typed correctly. 
 

Then, click on the Send button, 
or  

press and hold down Ctrl on the  
keyboard and press the Enter key at the 
same time. 

 
The email should now be sent. 
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Shortcuts 
 
When using Microsoft Outlook, there are a number of shortcut keys which can be used.  
 
Below is a list of some of the most useful shortcuts. 
 

Task Shortcut keys 
Open the Help window F1 

Select all messages CTRL + A 

Print a selected message CTRL + P 

Delete an email Delete or CTRL + D 

Open a new message CTRL + N 

Reply to an email CTRL + R 

Forward a message CTRL + F 

Open a selected message CTRL + O  

Close a message ESC 

Send a message CTRL + ENTER  

Spell check F7 

 
 

Spacing 
 

Make a space between words 
 
Press the long key at the bottom of the keyboard once.  This key is called the spacebar.  
 

Move down to the next line 
 
Press one of the enter keys on the keyboard. 
 
 
  or 
 
To leave a blank line, you will need to press the enter key twice. 
 
There should be one space between words and after a comma. 
 
After a full stop, exclamation mark or question mark there should be either one or two 
spaces.  Choose the one you are going to use and make sure you are always consistent 
throughout the email.  Some examination bodies will state there must be two spaces. 
 
There should be one blank line between paragraphs. 
  

 Enter 
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Use an address book 
 
The example used is Microsoft Outlook.  You may not 
be using this, but there will be similar buttons in the 
program you are using. 
 
When sending a message, the email address needs to 
be entered into the To box. 
 
To insert email addresses which are already stored in 
your address book, click on the To button. 
 
An address book will appear with all your saved email 
addresses to choose from. 
 
If necessary, select the folder where your contacts are stored.   
 
Click on the 
name of the 
contact you 
would like to 
send the 
email to. 
 
Then, click 
on the To 
button.  
 
The contact 
that you 
have 
selected will 
appear in the 
To box. 
 
When you 
have chosen 
who you 
want to receive the email, click on the OK button. 
 
To send the same message to many people from the list of contacts in your address book, 
just keep adding the names before clicking on the OK button. You will have more than one 
contact in the Message recipient box, if this has been done correctly. 
 
Sending a copy (Cc) or blind copy (Bcc) of the email to a contact in the address book can 
be done using the same process as the To button.  
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Video conferencing 
 
It is possible to use two-way video and audio technology to connect two or more people or 
groups of people, in different places, to allow them to be able to see and speak to each 
other.  This is called video conferencing.  Any information displayed on your computer or 
whiteboard can also be shared during a video conference. 
 
This is a fast way of having meetings with people all over the world without them having to 
travel. 
 
This can be used by people with family in other countries to allow them to keep in touch. 
 
 
 
 


